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Overview 

Version 2015 Revisions 

Added the ability to Print out Striplogs and Core Logs to a continuous tiff file (no page breaks) 
including Striplog headers, location maps, survey views, legends and formation tops. 

Added an option on the View menu to extend the Curve display in the TVD and SS display in both 
Power*Log and Power*Core to display the curve data past the old limitations of 2 subsequent 90 degree 
or 1 survey greater than 90 degree that would cut the entire display off. The user now has the ability to 
keep the curve display going. 

Bit Record Report - We have added the Additional fields required for the latest PDC and Roller Cone 
IADC Bit Classification as well as 2 more liner sizes (surface, intermediate and main) to the Pump data 
section. The printed reports also reflect these changes. 

Added a 1:1 Depth Scale ratio to the log scale menu selection to see the core photos in real life scale. 

Added a Core Photo Cropping tool to easily crop core photos from the core box pictures and add them 
to a core log for depth correction. 

Added a Core Photo Stacking layer / track with the ability to crop photos, rotate photo, identify rubble or 
slough intervals, split and lock photos to a depth, shrink and stretch individual core sleeves or all sleeves 
between to lock points and move all cored intervals up or down. This layer should be able to depth correct 
core photos to log data quickly and easily. 

Added a Core # and Sleeve data layer / track to display the data determined in the Core photo stacking 
layer and give the user the ability to export this data for Core Photo annotations. 

Added an Interpretive Facies layer / track that mimics the Interpretive Lithology layer to handle all bed 
restricted layers so that when you change a facies interval all bed restricted layers will amend with those 
revisions. This layer also has the Dean Stark test intervals imbedded into them with a min / max test 
interval, and a maximum lost core interval to give the user the ability to automate the Dean Stark interval 
calculations so the test will never go over facies boundaries or areas of lost core too large. 

Added an Automated Dean Stark or NMR test intervals calculator layer / track which enables the 
user to easily indicate the test intervals and export that data for the laboratory to perform their tests. The 
user also can modify this data if they so wish. 

Added an Automated Test Intervals calculator layer / track which enables the user to easily indicate 
the other test intervals (PSD, MB, SI, Sieve, VOB, OB and Coulter) which can be locked to the Dean 
Stark intervals and export that data for the laboratory to perform their tests. The user also can modify this 
data if they so wish. 

Added a Single Test Intervals indicator layer which enables the user to easily indicate the single point 
tests (XRD, SEM, Thin Sections) and export that data for the laboratory to perform their tests 

Revised the Percent layer / track to add a manual keyboard entry to go along with the mouse pointer 
entry we had previously and import ASCII file data. 

Added a Ranged Data layer / track to display this type of data (1212 – 1214m, 2.321 microns) and the 
ability to manually input data or import ASCII file data. 

Added a V Shale Gamma Ray (GR) layer / track to calculate the volume of shale from a gamma ray 
curve in the various calculation methods (Index ratio, Steiber, Clavier, Tertiary Rocks and Older Rocks). 

Added a V Shale Porosity (POR) layer / track to calculate the volume of shale from the Neutron Density 
Porosity curves. 

Added a V Shale Minimum (Min) layer / track to calculate the volume of shale from the lesser of the two 
calculated curves Volume shale GR and Volume shale POR curves. 
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The user can now control the Bed Restricted layers with either an Interpretive Facies Layer or an 
Interpretive Lithology Layer. By doing so we have added another system log for both Metric and 
Imperial for Interpretive Facies logs.  

Interpretive Lithology Layer / Track – We have added the ability to Insert a Lithology to a Facies. If an 
Interpretive Facies has been inserted the user can now CTRL Key depressed and double click with the 
mouse to fill in a selected rock type into the top and base depths of the preexisting Facies. 

Interpretive Lithology Layer / Track – We have added the Ability to Delete Multiple Lithology or Bed 
Intervals. 

Interpretive Lithology Layer / Track – We have added an Interval Button to the builder to enable the 
user to find any really small beds that are not discernable to the eye. 

Print WE / AM and Reports to word. We have added subsea values to the Morning reports and the 
Survey Reports. We have also added the AER UWI requirements to all the reports as well as the Strip 
and Core log headers. 

Revised LAS Export Utility for Curve data to include the TVD and Subsea Values to the export file data 
and included the AER board requirements from Directive 80. 

Revised LAS Export of Well data to include only certain well log data including only relevant log data 
and creating a menu item to easily get to the LAS Well data file creation. 

We have added to the Import Toolbar / Menu Item the ability to Import Percent Data (ie 1200-1202m, 
34%), Import Ranged data (ie 1200-1202m, 3.24 microns) and Import Core Photos to the Core Photo 
stack layer. 

We have added to the Export Toolbar / Menu Item the ability to Export the automated Dean Stark tests 
intervals, the Interval test intervals, the single point test points and Core Sleeve data including Slough 
and rubble zones. 

Right Click menu options. We have added the Layers Organizer to the Edit Options selection. 

We have added the ability to Export Power*Suite Data in Wellsight Format. 

Reformatted the Import and Export File menu items to group them better. 
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File Menu – Import Menu - Core Photos 
This method will allow the user to import ASCII or csv file formats into our database. We cannot import xls or any 
other type of spreadsheet format. If the data comes that way you must resave it in another format before attempting 
to import the data. The actual core photos are not imported into the database. With MS Access the database is 
limited to 2GB and core photos can be up to 60MB each. This would seriously hinder the amount of data so we need 
to have the files stored on the hard drive of the computer. You will need a photo cropping template and location, 
photo name and location, Core #, Core top, Core Base and Recovery in a file. 

How to Import Core Photos 

1. To access the Core Photos Import window, click on Import under File to activate the pop-out menu and then 

select Core Photos or click on the  Import Core Photos Icon on the Import Toolbar. This will activate the 
open Core Photo data file window as shown below. 

 
2. Select the file from the folder or drive with 

the corresponding navigational tools provided and either double click on the file name or click once on the file 

name and click on the  button. This will activate the Set delimiter window as shown below. 
N.B. The one on the left the delimiter is set correctly the one on the right the delimiter is set incorrectly. 

Correct  Not Correct  
3. Highlight the correct corresponding  button beside Comma, TAB or Space delimiter (if shown correctly the 

Example should read <column-break> between the data columns. If you see this then click on the  
button to close this window and activate the Directional survey import window shown on the next page. 
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Overview of the window. 
The left hand side of the Core Photo Data Import window allows the user to view the different data columns 
represented in the file numbered in ascending order. 
The right hand side of the Core Photo Data Import window allows the user to see the data fields associated with 
the Core Plug Data Table supplied by Power*Suite. 

 Button allows the user to open another Core Photo data file after the Import window has been opened. 

 Button allows the user to utilize the mapping file saved from above to remap data columns in the 
survey file to database fields in the survey point table in the database. 

 Button allows the user to save the mapping between data columns in the survey file to database fields 
in the Core Photo table in the database. Once the initial mapping has been done and saved, the user can utilize this 
mapping file so you do not have to repeat the clicking of dragging of data columns to database fields in the survey 
point table again and again if you do not want to. 

 Button allows the user to undo all the mapping from data columns in the survey file to database fields 
in the survey point table that was done either by dragging or by utilizing the mapping file. 

 Button allows the user to open the file in Word pad to look at the file format and possibly make changes to 
the data file prior to importing the files data. 

 Button reloads the data into the sample portion of the file window. 

Importing / Mapping of Core Photo data. 
1. On the left side of the window Click and drag the data column you wish to import to the corresponding table 

field on the right side and release it when the field becomes highlighted. If mapped the field  will turn green 
on the right and red on the left. 

N.B. The user can Right click on the Field to remove the mapping. 
2. Repeat the Clicking and Dragging of data columns to fields until all the columns that you want have been 

mapped. 
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3. The user can save this mapping procedure at this time by clicking on the  button and giving this 
procedure a file name and folder to be used again at a later date when you would have to import this data again. 

4. Click on the  button. After the data has been imported you will be prompted with a system message. 

 

5. Acknowledge the Import message. Click on the  button and then click on the  to exit or 

click on the  button to close the Window. 

How to Import Core Photo Data with an Existing mapping file. 
1. To access the Core Plug Import window, click on Import under File to activate the pop-out menu and then select 

Core Photos or click on the  Import Core Photo Icon on the Import Toolbar. This will activate the open 
Core Photo data file window as shown below. 
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2. Select the file from the folder or drive with the corresponding navigational tools provided and either double 

click on the file name or click once on the file name and click on the  button. This will activate the 
Set delimiter window as shown below. 

N.B. The one on the left the delimiter is set correctly the one on the right the delimiter is set incorrectly. 

Correct  Not Correct  
3. Highlight the correct corresponding  button beside Comma, TAB or Space delimiter (if shown correctly the 

Example should read <column-break> between the data columns. If you see this then click on the  
button to close this window and activate the Directional survey import window shown on the next page. 

4. In the upper portion of the window click on the  button. This will activate an open file window. 

 
5. Select the mapping file with the *.cpm saved from previous imports of similar core data files to your core plug 

table by highlighting the file and clicking on the  button or double clicking on the file name. Once the 
file has been opened it will refresh with the current mapping configuration as shown below. 

N.B. The user can Right click on the Field to remove the mapping. 

6. The user can map more data columns on the left side of the window by Clicking and dragging the data 
column you wish to import to the field on the right side and release it when the field becomes highlighted. 

 

7. Click on the  button. After the data has been imported you will be prompted with a system message. 
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8. Acknowledge the Import message. Click on the  button and then click on the  to exit or 

click on the  button to close the Window. 

File Menu – Import Menu - Percent Data 
This method will allow the user to import ASCII, space, comma or tab delimited file formats into our database. We 
cannot import EXCEL or any other type of spreadsheet format. If the data comes that way you must resave it in 
another format before attempting to import the data. Also a Percent Layer must be added to your log for you to be 
able to import data into the percent data tables. 

Importing Percent Data 
1. To access the Percent Data Import window, click on Import under File to activate the pop-out menu and then 

select Percent (%) or click on the  Import Percent (%) button on the Import Toolbar. This will activate the 
open Percent Data file window as shown below. 

 
2. Select the file from the folder or drive with the corresponding navigational tools provided and either double 

click on the file name or click once and click on the  button. This will activate the Set delimiter 
window as shown below. 

N.B. The one on the left the delimiter is set correctly the one on the right the delimiter is set incorrectly. 

Correct  Not Correct  
3. Highlight the correct corresponding  button beside Comma, TAB or Space delimiter (if shown correctly the 

Example should read <column-break> between the data columns. If you see this then click on the  
button to close this window and activate the Percent Data Import window shown below. 
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Overview of the window. 
The left hand side of the Percent Data Import window allows the user to view the different data columns 
represented in the file numbered in ascending order. 
The right hand side of the Percent Data Import window allows the user to see the data fields associated with the 
Dip Meter Table supplied by Power*Suite. 

 Button allows the user to open another Slide data file after the Import window has been opened. 

 Button allows the user to utilize the mapping file saved from above to remap data columns in the 
Percent data file to database fields in the Percent table in the database. 

 Button allows the user to save the mapping between data columns in the Percent data file to database 
fields in the Percent table in the database. Once the initial mapping has been done and saved, the user can utilize 
this mapping file so you do not have to repeat the clicking of dragging of data columns to database fields in the dip 
meter table again and again if you do not want to. 

 Button allows the user to undo all the mapping from data columns in the slide data file to database 
fields in the Slide table that was done either by dragging or by utilizing the mapping file. 

 Button allows the user to open the file in Word pad to look at the file format and possibly make changes to 
the data file prior to importing the files data. 

 Button reloads the data into the sample portion of the file window. 

Importing / Mapping of Percent data. 
A Percent Data Layer should already have been added through the Log configuration builder so that the user has a 
Percent Data type layer to import to. Otherwise it would be impossible to import any data. 

1. On the left side of the window Click and drag the data column you wish to import to the corresponding table 
field on the right side and release it when the field becomes highlighted. If mapped the field  will turn green 
on the right and red on the left. 

N.B. The user can Right click on the Field to remove the mapping. 
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2. Repeat the Clicking and Dragging of data columns to fields until all the columns that you want have been 
mapped. 

 

3. The user can save this mapping procedure at this time by clicking on the  button and giving this 
procedure a file name and folder to be used again at a later date when you would have to import this data again. 

4. Click on the  button. After the data has been imported you will be prompted with a system message. 

 

5. Acknowledge the Import message. Click on the  button and then click on the  to exit or click on 

the  button to close the Window. 

How to Import Percent Data with an Existing mapping file. 
1. To access the Percent Data Import window, click on Import under File to activate the pop-out menu and then 

select Percent (%) or click on the   Import Percent data button on the Import Toolbar. This will activate the 
Open Percent Data file window as shown below. 
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2. Select the file from the folder or drive with the corresponding navigational tools provided and either double 

click on the file name or click once and click on the  button. This will activate the Set delimiter 
window as shown below. 

N.B. The one on the left the delimiter is set correctly the one on the right the delimiter is set incorrectly. 

Correct  Not Correct  
3. Highlight the correct corresponding  button beside Comma, TAB or Space delimiter (if shown correctly the 

Example should read <column-break> between the data columns. If you see this then click on the  
button to close this window and activate the Percent Data Import window shown below. 

 

4. In the upper portion of the window click on the  button. This will activate an open file window. 
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5. Select the mapping file with the *.pct saved from previous imports of similar Percent data files to your percent 

table by highlighting the file and clicking on the  button or double clicking on the file name. Once the 
file has been opened it will refresh with the current mapping configuration as shown below. 

N.B. The user can Right click on the Field to remove the mapping. 

6. The user can map more data columns on the left side of the window by Clicking and dragging the column you 
wish to import to the field on the right side and release it when the layer becomes highlighted. 

 

7. Click on the  button. After the data has been imported you will be prompted with a system message. 

 

8. Acknowledge the Import message. Click on the  button and then click on the  to exit or click on 

the  button to close the Window. 

File Menu – Import Menu - Ranged Data 
This term may not mean much to you but it is similar to curve data but has a value over a range of depths. To 
successfully import Range Data you must first add a range data type layer or track to your log. 
1. To access the Ranged Data Import window, click on Import under File to activate the pop-out menu and then 

select Ranged Data or click on the  Ranged Import button on the Import Toolbar. This will activate the 
open Ranged Data file window as shown below. 
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2. Select the file from the folder or drive with the corresponding navigational tools provided and either double click 

on the file name or click once and click on the  button. This will activate the Set delimiter window as 
shown below. 

N.B. The one on the left the delimiter is set correctly the one on the right the delimiter is set incorrectly. 

Correct  Not Correct  
3. Highlight the correct corresponding  button beside Comma, TAB or Space delimiter (if shown correctly the 

Example should read <column-break> between the data columns. If you see this then click on the  
button to close this window and activate the Range Data Import window shown below. 
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Overview of the window. 
The left hand side of the Range Data Import window allows the user to view the different data columns 
represented in the file numbered in ascending order. 
The right hand side of the Range Data Import window allows the user to see the data fields associated with the 
Dip Meter Table supplied by Power*Suite. 

 Button allows the user to open another Range data file after the Import window has been opened. 

 Button allows the user to utilize the mapping file saved from above to remap data columns in the Slide 
data file to database fields in the Range table in the database. 

 Button allows the user to save the mapping between data columns in the Range data file to database 
fields in the Range Data table in the database. Once the initial mapping has been done and saved, the user can 
utilize this mapping file so you do not have to repeat the clicking of dragging of data columns to database fields in the 
dip meter table again and again if you do not want to. 

 Button allows the user to undo all the mapping from data columns in the slide data file to database 
fields in the Range data table that was done either by dragging or by utilizing the mapping file. 

 Button allows the user to open the file in Word pad to look at the file format and possibly make changes to 
the data file prior to importing the files data. 

 Button reloads the data into the sample portion of the file window. 

Importing / Mapping of Ranged data. 
A Range Data Layer should already have been added through the Log configuration builder so that the user can see 
their imported Ranged data layer when you import the data. Otherwise you will not be able to import this data. 
1. On the left side of the window Click and drag the data column you wish to import to the corresponding table 

field on the right side and release it when the field becomes highlighted. If mapped the field  will turn green 
on the right and red on the left. 

N.B. The user can Right click on the Field to remove the mapping. 

2. Repeat the Clicking and Dragging of data columns to fields until all the columns that you want have been 
mapped. 
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3. The user can save this mapping procedure at this time by clicking on the  button and giving this 
procedure a file name and folder to be used again at a later date when you would have to import this data again. 

4. Click on the  button. After the data has been imported you will be prompted with a system message. 

 

5. Acknowledge the Import message. Click on the  button and then click on the  to exit or click on 

the  button to close the Window. 

How to Import Ranged Data with an Existing mapping file. 
1. To access the Ranged Data Import window, click on Import under File to activate the pop-out menu and then 

select Percent (%) or click on the  Import Percent data button on the Import Toolbar. This will activate the 
Open Percent Data file window as shown below. 

    
2. Select the file from the folder or drive with the corresponding navigational tools provided and either double 

click on the file name or click once and click on the  button. This will activate the Set delimiter 
window as shown below. 

N.B. The one on the left the delimiter is set correctly the one on the right the delimiter is set incorrectly. 

Correct  Not Correct  
3. Highlight the correct corresponding  button beside Comma, TAB or Space delimiter (if shown correctly the 

Example should read <column-break> between the data columns. If you see this then click on the  
button to close this window and activate the Percent Data Import window shown below. 
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4. In the upper portion of the window click on the  button. This will activate an open file window. 

 
5. Select the mapping file with the *.mg saved from previous imports of similar Range data files to your range data 

table by highlighting the file and clicking on the  button or double clicking on the file name. Once the 
file has been opened it will refresh with the current mapping configuration as shown below. 

N.B. The user can Right click on the Field to remove the mapping. 

6. The user can map more data columns on the left side of the window by Clicking and dragging the column you 
wish to import to the field on the right side and release it when the layer becomes highlighted. 
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7. Click on the  button. After the data has been imported you will be prompted with a system message. 

 

8. Acknowledge the Import message. Click on the  button and then click on the  to exit or click on 

the  button to close the Window. 

File Menu - Export Menu - Core Interval Test Data 
This utility exports your Core Interval Test data (that can be locked to the Dean Stark Intervals or can be random) to 
pass back to the Laboratory for different Test Intervals to be done on the core. The Core Interval Test data contains 
the Test #, Test Type (layer name) along with the top and bottom of each Test. This data can be exported into 3 file 
formats which can then be used by other applications. 

Exporting Core Interval Test Data 

To access the Core Test Interval Data export window, click on Export under File to activate the pop-out menu and 

then select Core Interval Test. You can also select the  Icon on the Export toolbar. This will activate the Export 
Core Test Intervals window. 
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1. Click on the radio button next to the type of the file that you would like to create. 

2. Click on the  button. This will activate a Specify Core Interval Test Export File Name window. 

 
3. Type in a file name and select the drive and directory you wish the survey to be exported to. Then, click on the 

 button. This will activate the System Information window asking you if you wish to proceed. 

 

4. Click on the  button. This will activate the Core Interval Test Export File Created window. 

 

5. Click on the  button to exit Export Interval Test window. 

File Menu - Export Menu - Core Test Points Data 
This utility exports your Core Point Test data to pass back to the Laboratory for different Test Points to be performed 
on the core. The Core Point Test data contains the Test #, Test Type (layer name) along with test point for each Test. 
This data can be exported into 3 file formats which can then be used by other applications. 

Exporting Core Test Points Data 

To access the Core Test Points Data export window, click on Export under File to activate the pop-out menu and 

then select Core Point Tests. You can also select the  Icon on the Export toolbar. This will activate the Export 
Core Test Point window. 
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1. Click on the radio button next to the type of the file that you would like to create. 

2. Click on the  button. This will activate a Specify Core Point Tests Export File Name window. 

 
3. Type in a file name and select the drive and directory you wish the survey to be exported to. Then, click on the 

 button. This will activate the System Information window asking you if you wish to proceed. 

 

4. Click on the  button. This will activate the Core Point Tests Export File Created window. 

 

5. Click on the  button to exit Export Point Tests window. 
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File Menu - Export Menu - Core Sleeve Data 
This utility exports your (presumably) depth corrected Core Sleeve data after the Core Photos have been imported 
and cleaned up to pass back to the Laboratory label the core photos with the corrected depths. The Core sleeve data 
contains the Core #, Sleeve # along with the top and bottom of each sleeve. Also contained in this data are the core 
designation types for rubble and slough. This data can be exported into 3 file formats which can then be used by 
other applications. 

Exporting Core Sleeve Data 

To access the Export Core Sleeve Data window, click on Export under File to activate the pop-out menu and then 

select Export Core Sleeve data. You can also select the  Icon on the Export toolbar. This will activate the Export 
Core Sleeve Data Intervals window. 

 

1. Click on the radio button next to the type of the file that you would like to create. 

2. Click on the  button. This will activate a Specify Core Sleeve Data Export File Name window. 

 
3. Type in a file name and select the drive and directory you wish the survey to be exported to. Then, click on the 

 button. This will activate the System Information window asking you if you wish to proceed. 

 

4. Click on the  button. This will activate the Core Sleeve Data Export File Created window. 

 

5. Click on the  button to exit Export Core Sleeve Data window. 
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File Menu - Export Menu - Dean Starks Test Data 
This utility exports your Calculated Dean Starks Intervals automated by the system with the help of the Interpretive 
Facies layer. This data will be pass back to the Laboratory for the Dean Stark intervals to be performed on the core. 
The data contains the Test Type (layer Name), Test #, along with the top and bottom of each test interval. This data 
can be exported into 3 file formats which can then be used by other applications. 

Exporting Dean Starks Test Data 

To access the Export Dean Starks Test Data window, click on Export under File to activate the pop-out menu and 

then select Export Dean Starks Test Data. You can also select the  Icon on the Export toolbar. This will activate 
the Export Dean Starks Test Data window. 

 

1. Click on the radio button next to the type of the file that you would like to create. 

2. Click on the  button. This will activate a Specify Dean Stark Export File Name window. 

 
3. Type in a file name and select the drive and directory you wish the survey to be exported to. Then, click on the 

 button. This will activate the System Information window asking you if you wish to proceed. 

 

4. Click on the  button. This will activate the Dean Stark Export File Created window. 

 

5. Click on the  button to exit Export Dean Stark Data window. 
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File Menu – Export - LAS Files (Curves) 
The Power*Suite LAS Export Utility program can be accessed through the Power*Suite folder and facilitates 
the export of Power*Suite curve data into an LAS File. 

1. Under the File menu selection, click on Export, click on LAS. You can also select the  Icon on the Export 
toolbar. This will activate the LAS Export window. 

          

2. Click on the  button. This will activate a list of all the wells in your Database. 
3. Select the well you wish to export your LAS Curve data for by clicking on the well name and then clicking on 

the  button or by double click on the well. You should now see your well name in the field beside 

the  button. Also, you should see a list of curves in the Curve List field. An example of this is shown on 
the next page. 

4. Click on the  button and type in a file name and path for that file in the window. Click on the 

 button when you have done. 
5.  The user can export Version 2 (checked) or Version 3 file format (unchecked). 
6. Select the Curves you wish to create a file for by click on the curve name in the Curve name field or by 

clicking on the  button to select all the curves. 
7. Select the step type you wish to use for the export. 

Extrapolate will give you the best incremental data utilizing a constant step extrapolating the data to replicate this 
constant step. The Curve depths selection will merge the curves (if more than one curve is selected) and will export 
the data as it has been collected into the database. 
8. Type in an appropriate step (depth increment) or utilize the default 1 m depth increment. 
9. Optional Type in an interval in the From and To fields and deselect the Extract Interval All check box if you wish 

to export just a portion of the curve data. 
10. Optional If the user wishes to Change Null Value. 

a. Click on the  button. This will activate a Null Value window. 

 
b. Type in another Null value if the default null value of –999.25 is not what you want for a null value 

and then click on the  button. 
11. Optional Select the reverse direction check box if you want the data in descending order. 
12. Optional Select the other depth units other than (MD) Measured Depth (default) to be included with your LAS 

file. Click on one or both of the check boxes  beside the other such selections as (TVD) True 
Vertical Depth or (SSL) Subsea Level. 
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13. Click on the  button. This will activate a LAS file generation window indicating which curves are being 
exported. Then the process amalgamates all the curve data into a single LAS File. When the file generation has 
been completed a System Message will be generated. 

Note: There may be a message box encountered during this process indicating some of the curves selected have no 
data. You will have a choice of not including these curves in the LAS Export file. 

 

14. Once the File has been created acknowledge the ensuing message by clicking on the  button. 

15. Click on the  button to Close the application or repeat steps 2-13 to create more LAS Curve data files. 
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File Menu – Export Menu - Well Data as LAS Version 3. 
This utility exports all your well data including curve data from your database in LAS Version 3 format. 

Exporting LAS Well Data 

Click on Export under File to activate the pop-out menu and then select Well as LAS. You can also select the  
Icon on the Export toolbar. This will activate the Export Well LAS File. 

 

1. Click on the Data Types you want in the LAS File. The data types highlighted will be included. You can turn on / 
off the highlight by clicking on the data types. 

2. The  button will select all the data categories and the  button will deselect all the data 
categories. 

3. Define the Export Interval for your data. 
4. Define the step interval for your data. 
5. Click on the  button. This will activate a Save LAS File Name window. 

 
6. Type in a file name and select the drive and directory you wish the survey to be exported to. Then, click on the 

 button. Your file name will be created in the folder you directed it to. 
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File Menu – Export Menu – WS Format (Wellsight file format) 
This utility exports some of your well data including curve data from your database in Wellsight format. 

Exporting Well Data 

1. Click on Export under File to activate the pop-out menu and then select WS format. You can also select the 

 Icon on the Export toolbar. This will activate the Alternate Format window. 

 

2. Click on the Data Types you want in the WS Data File. The data types highlighted will be included. You can turn 
on / off the highlight by clicking on the data types. 

3. The  button will select all the data categories and the  button will deselect all the data 
categories. 

4. Define the Curve Step you want for the curve data in the Curve step field. All other data will be exported with ½ 
meter step. 

5. Click on the  button. This will activate a Save Alternate format File Name window. 
6. Type in a file name and select the drive and directory you wish the survey to be exported to. Then, click on the 

 button. Your file name will be created in the folder you directed it to. 

File Menu - Print to TIFF (file format) 
Prints all or part of your log/well along with the Title page, location map, legends, survey views, 
individualized cores and formation tops on a continuous basis in a tiff file format. 

1. Under the File menu selection, click on Print to TIFF or click on the  Print to TIFF button on the Toolbar to 
activate the Print to TIFF window shown below: 

Note: The depth views associated with the Print TIFF window are defaulted to the Depth View that Power*Log / Curve 
/ Core is in at the time of the activation of the Print to TIFF window. 
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2. Select the appropriate paper orientation from this drop box field and the Title 
Page, Legend, and Formation Tops will automatically conform to the selected orientation. There are four (6) 
types of paper orientation to choose from: letter (8.5”x11”) portrait or landscape, legal (8.5”x14”)portrait or 
landscape, tabloid (11”x15”) portrait or landscape settings. 

3.  Activate this check box , if you wish to printout a Title Page. 
4. The Type (Title Page) drop box displayed on the right allow you to pick the appropriate title 

page format to print. The standard selection prints out our full blown title page with most of 
the Wells data. You can also select our abbreviated title pages that handle core and borehole 
logs 

5. If you are printing the Standard Title page and you are in Alberta the AER format should be 
selected. 

N.B. This format changes our UWI printout from 100121605812W500 to 00/12-16-058-12W5/0 only on the Striplog 
Title page. All other UWI formats remain the same. 

6. Activate this check box , if you wish to printout a logo, and then select a logo from the 
Logo drop box field. 

Note: The logo file format must be a bitmap image file (*.bmp) if you want a logo printed out on the title page. Also, it 
is recommended that the bitmap image should be a square image, because Power*Suite will shrink or expand the 
image to fit the logo space on the Title Page. This bitmap must be placed in the Powersuite_2015\logo directory for 
the application to find it. 

7. Type any pertinent comments into the Title Page Remarks field and they will be displayed accordingly on the 
Strip Log Title Page only. 

8.  Activate this check box , if you wish to printout a location 
map following the title page, and then the user select a location map from your computers drives by clicking on 

the  and finding the file you want to print out as a location map. 

Note: The location map file format must be a bitmap image file (*.bmp) if you want a location map to be printed out. 
Also, the bitmap image must be a square image, because Power*Suite will shrink or expand the image to fit the 
location map space following the Title Page. This bitmap can be placed anywhere as the file location is saved within 
the Power*Suite ini file. 
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9. Survey views  Activate this check box , if you wish to have the plan view (view of the well bore from 
surface) printed out in the striplog header as captured in the Survey View application. 

10. Survey views  Activate this check box , if you wish to have the user defined view (view of the well 
bore as manipulated by the user) printed out in the striplog header as captured in the Survey View application. 

11. Survey views  Activate this check box , if you wish to have the azimuth view (view of the well bore 
along the target azimuth) printed out in the striplog header as captured in the Survey View application. 

12. Survey views  Activate this check box , if you wish to have the cross section view (view of the well 
bore at right angles to the target azimuth) printed out in the striplog header as captured in the Survey View 
application. 

13. Survey views  Activate this check box , if you wish to have all the views printed out in the striplog 
header as captured in the Survey View application. 

14.  Activate this check box , if you wish to have our entire legend printed out. 
15.  Activate this check box , if you wish to have the legend reflect only the symbols printed on 

the log or core portions of the printed intervals defined in the log and core portions of the print log 
window. 

In the Log portion of the Print Log window 

16. Select or type in the Scale for the main log to be printed out at, in the Scale drop box field. 

Note: If you see 2” or some other inch related printing scale and you want to see a ratio type scale Change the 
System Options under the Options pull down menu and activate the Display Tab and Activate this check box  
beside Use Metric Style Scales. 
The Well Section interval is derived from the Top and Base Depth values entered into the Print Sections window 
under the Edit pull down menu. (see Print Sections). 
The Lithology Section interval is derived from what has been drawn into the interpretive lithology track of the well 
that is being printed. 

17.  Activate this check box  to have the track headers /footers printed out with the main log. 
18.  Activate this check box  to have the core accessories 

printed out on the main log. 

19. Highlight the log printing options in the selection box. The user can select 
either None, User-defined Interval (requires that you manually enter the 
desired print interval depths), Today Section, Well Section, or Lithology 
Section. 

Note: Today Section interval is derived from the From and To Depth values entered into the Today’s Section 
portion of the Power*Log Data Transfer: Export window. 
The Well Section interval is derived from the Top and Base Depth values entered into the Print Sections window 
under the Edit pull down menu. (see Print Sections). 
The Lithology Section interval is derived from what has been drawn into the interpretive lithology track of the well 
that is being printed. 

20. If user defined interval is chosen the user can select which depth type, either measured depth, true 
vertical depth or subsea level depth from the depth measurement drop box. The user must also type in 
the depth interval to be printed. 

Note: The log itself must be displayed in whatever depth view you wish to print before you activate the print log 
window. To change the log to the desired format, refer to depth view under the view pull down menu. 

In the Cores portion of the Print Log Window 

21. If you are printing out a Core log on the tail of the striplog, select the Cores you wish to print by highlighting 
them. 

22.  Select or type in the Scale for the core log to be printed out at in the Scale drop box field. 
23.  Activate this check box  to have the track headers / footers printed out with the core log. 

Note: A separate Header Information Box is automatically printed out with every Core and includes the Core 
Scale, Core Date, Core Number, Cored Interval, Amount Cut, Amount Recovered, and Percentage. 

**A value must be entered into the Core Scale field in order to printout anything. ** 

24.  Activate this check box  if you wish to printout Formation Tops and the Formation Tops will be 
included on a separate page at the end of the log printout. 
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 The page margin field is available, primarily, when you are printing to Adobe Acrobat writer. When 
a numerical value in inches is typed into this field it will initiate a top and left margin for the templates (Title 
Page, Legend and Formation Tops) as well as a left margin for the main log. 

25. When you are ready to print your log, click on the  button. 

26. This will activate a message box indicating the size of your printout. Click on the 
button. 

27. This will activate a file name window which should be filled in with your file name and location to 
where you can locate it for further reference. 

Note: If you do exit from the Print to TIFF window, you will be asked if you wish to save the print settings. If you 
click on Yes, the program will remember every setting that you made to the Print to TIFF window and then will 
default to those settings the next time you enter the Print to TIFF window 

View Menu - TVD Cut Off at 90o
When the user is in the TVD or SS depth mode this selection will either allow the curve data to 
extend past our basic cut off of angle of 90o or greater or not. This could help is figuring out where 
you could be in the section. This only applies to Curve data and applies to all curves in Power*Log 
or Power*Core applications that has the TVD module activated and has Directional Surveys. 
 
 
 
 
 
 

Automated Dean Stark Calculator Layer / Track 
This layer allows the user to calculate Dean Stark Test Intervals automatically but this layer requires Stacked Core 
Photos and Interpretive Facies Layers data for this to work. This layer is only available with our Power*Core 
application Version 2015 and beyond. This automation will only be done if you have the Interpretive Facies filled 
along with the Core Photo’s stacked. This should be the last thing you perform after the core has been depth 
corrected and the facies have been entered. The User can also enter in the data by mouse pointer or keypad 
methods. 

How to Add a Dean Stark Test Intervals Track 

1. Click on Log Configuration Builder under the Options menu selection or click on the  Log 
Configuration Builder button on the Toolbar to activate the Log Configuration Builder window: 
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2. On the left hand side of the Log configuration window scroll down the list of tracks and click on the Auto 
Dean Stark Calculator track. The track will become highlighted and the Tracks radio button  will become 
activated. 

3. On the right hand side of the Log configuration window click on the Track you want it to go above or to the left of. 
In this example we will be adding the Auto Dean Stark Calculator track to the left of the DS Intervals. The track 
will become highlighted and the Tracks radio button  will become activated. 

4. In the middle of the Log configuration window click on the  button. This will activate a System 
Message asking the user “Do you really want to ADD the selected (TRACK) from the available log to the active 
log?” 

5. Click on the  button. This will activate a Get Name window allowing the user to name the track. 

 

6. Type in a new Track name or keep the existing name and then click on the  button.  The track will be 
added above the DS Intervals Track or to the left on the log, and the Log Configuration Builder window will be 
shown. 

 

7. Click on the  button. This will activate the Log with the new track and you will then prompted with the 
Current Core Photo group that has been used for the Core Photo Stack layer. Drop the Group ID drop box and 
select the Photo Group for this layer. 

Note: This Current core photo group is the same group that will be used in the Stacked Core Photo layer as well as 
the Core # and Sleeve data layer and the Automated Test Interval Calculator layers. 

 

Automated Method 
1. Double click on the Auto Dean Stark Calculator track / layer to activate the Dean Stark Test Intervals Builder 

window. 
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2. Right click anywhere on the Auto Dean Stark Calculator track / layer to activate the pop-up menu. 

 
3. Click on the Calculate Dean Stark Intervals selection and the Intervals will be calculated for you. This will only 

be done if you have the Interpretive Facies filled along with the Core Photo’s stacked. This should be the last 
thing you perform after the core has been depth corrected and the facies have been entered. 

4. Press the Esc key on the keyboard to exit from the Dean Stark Interval Builder window. 

Manually entering a Test Interval 
1. Double click on the Auto Dean Stark Calculator track / layer to activate the Dean Starks Intervals Builder 

window. 

 

Mouse Pointer Method 

2. Click on the  Button to clear the data entry form. 
3. Click and drag the Mouse Pointer within the Auto Dean Stark Calculator track / layer. 
4. Release the mouse button and the interval will be drawn with a 9999. 
5. Repeat Steps 2 – 4 for more intervals. 
6. When all your intervals have been entered you will want to Right Click on the layer to activate the pop out menu 

and select Renumber Intervals 

 

Or Keypad Method 

3. Click on the  Button to clear the data entry form. 

4. Type in a Top and Base Depth into the builder and then click on the  button. 
5. Repeat Steps 3-4 for more intervals. 
6. When all your intervals have been entered you will want to Right Click on the layer to activate the pop out menu 

and select Renumber Intervals 

Resizing an Interval 
1. Double click on the Auto Dean Stark Calculator track / layer to activate the Dean Starks Intervals Builder 

window. 
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2. Move the mouse pointer over the interval to be resized and Click once. This will activate the interval with the 
selection resize boxes. 

3. Hold the CTRL Key down and mouse over the edges and click and drag to a different interval. 

4. OR type in a new top and / or base depth and click on the  button. 

Deleting a Single Interval 
1. Double click on the Auto Dean Stark Calculator track / layer to activate the Dean Starks Intervals Builder 

window. 

 
2. Right click anywhere within the interval you wish to delete to activate the pop-up menu. 
3. Click on Delete option and the interval will be deleted accordingly. 
4. Repeat Steps 2 and 3 to delete more Dean Stark intervals from the Dean Stark track / layer. 
5. Once all your Dean Stark test intervals have been deleted, you will want them to come out sequentially by depth 

in the Export Utility you will want to right click on the track to activate the pop out menu and select Renumber 
Tests. 

6. Click on the  button or Press the Esc key on the keyboard to exit from the Dean Stark Builder window. 

Deleting Multiple Intervals 
1. Double click on the Auto Dean Stark Calculator track / layer to activate the Dean Stark Intervals Builder 

window. 

 
2. Press and Hold the SHIFT Key and then click and drag an area anywhere within the intervals you wish to 

delete. 
3. Release the mouse button to activate a Confirm Multiple Delete message. 

 

4. Click on  button and the Dean Stark intervals encompassed with your drag will be deleted 
accordingly. 

5. Once all your Dean Stark test intervals have been deleted, you will want them to come out sequentially by depth 
in the Export Utility you will want to right click on the track to activate the pop out menu and select Renumber 
Tests. 

6. Click on the  button or Press the Esc key on the keyboard to exit from the Dean Stark Builder window. 

Note: Every type of layer in Power*Log, Power*Core and Power*Curve has a Data Type classification. The default 

settings for the Auto Dean Stark Selector layer are shown below. To access this window, click on the  Layer 
Configuration button on the Toolbar, when the layer is active. 
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Automated Test Interval Calculator Layer / Track 
This layer allows the user to calculate other Test Intervals automatically but this layer requires Stacked Core Photos 
and Interpretive Facies Layers data, and can be tied to the previously entered Dean Stark intervals test for this to 
work. This layer is only available with our Power*Core application Version 2015 and beyond. This automation will only 
be done if you have the Interpretive Facies filled along with the Core Photo’s stacked. This should be the last thing 
you perform after the core has been depth corrected and the facies have been entered. The User can also enter in 
the data by mouse pointer or keypad methods. 
Note: If the Intervals are locked to the Dean Stark Intervals and the check box is activated then the intervals will be 
drawn in Pink and the intervals not locked to Dean Stark Intervals will be in Grey. Also Vice Versa, if the Locked 
option is unchecked then the locked intervals will be drawn in grey and the unlocked intervals will be drawn in pink. 
The user can only work with the intervals that are pink. 

How to Add an Auto Test Intervals Track 

1. Click on Log Configuration Builder under the Options menu selection or click on the  Log Configuration 
Builder button on the Toolbar to activate the Log Configuration Builder window: 

 
2. On the left hand side of the Log configuration window scroll down the list of tracks and click on the Auto 

Test Interval Calculator track. The track will become highlighted and the Tracks radio button  will 
become activated. 

3. On the right hand side of the Log configuration window click on the Track you want it to go above or to the left of. 
In this example we will be adding the Auto Test Interval Calculator track to the left of the DS Intervals. The track 
will become highlighted and the Tracks radio button  will become activated. 
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4. In the middle of the Log configuration window click on the  button. This will activate a System 
Message asking the user “Do you really want to ADD the selected (TRACK) from the available log to the active 
log?” 

5. Click on the  button. This will activate a Get Name window allowing the user to name the track. 

 

6. Type in a new Track name or keep the existing name and then click on the  button.  The track will be 
added above the DS Intervals Track or to the left on the log, and the Log Configuration Builder window will be 
shown. 

 

7. Click on the  button. This will activate the Log with the new track and you will then prompted with the 
Current Core Photo group that has been used for the Core Photo Stack layer. Drop the Group ID drop box and 
select the Photo Group for this layer. 

Note: This core photo group is the same group that will be used in the Stacked Core Photo layer as well as the Core # 
and Sleeve data layer and the Automated Dean Starks Calculator layers. 

 

Automated Method 
1. Double click on the Auto Test Interval Calculator track / layer to activate the Core Interval Test Builder 

window. 
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2. Right click anywhere on the Auto Test Interval Calculator track / layer to activate the pop-up menu. 

 
3. Click on the Lock to Dean Stark Intervals selection. This will lock the test intervals to the DS intervals 

previously entered. 
4. Right click anywhere on the Auto Test Interval Calculator track / layer to activate the pop-up menu. 

 
5. Click on the Fill Dean Stark Intervals selection. This will fill in the Test Intervals locked to the Dean Stark 

Intervals previously performed. This will only be done if you have the Dean Stark intervals were calculated. 
6. Press the Esc key on the keyboard to exit from the Test Interval Builder window. 

Manually entering a Test Interval 
1. Double click on the Auto Test Interval Calculator track / layer to activate the Core Interval Test Builder 

window. 

 
2. Right click anywhere on the Auto Test Interval Calculator track / layer to activate the pop-up menu. 

 
3. Click on the Lock to Dean Stark Intervals selection. This will lock the test intervals to the DS intervals. 
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Mouse Pointer Method 

4. Click and drag the Mouse Pointer within the Core Test Interval Calculator track / layer. 
5. Release the mouse button and the interval will be drawn with respect to the previously entered DS Interval and 

will be represented in pink. 

Note: If the Intervals are locked to the Dean Stark Intervals and the check box is activated then the intervals will be 
drawn in Pink and the intervals not locked to Dean Stark Intervals will be in Grey. Also Vice Versa, if the Lock is 
unchecked then the intervals will be drawn in grey. Now if you uncheck the Lock to Dean Stark Intervals the reverse 
will happen. The user can only work with the intervals that are pink. 

6. Repeat Steps 4 – 5 for more intervals. 
7. Once all your test intervals are entered or you have added more test intervals, you want them to come out 

sequentially by depth in the Export Utility you will want to right click on the track to activate the pop out menu 
and select Renumber Tests. 

8. Click on the  button or Press the Esc key on the keyboard to exit from the Core Point Test Builder 
window. 

Or Keypad Method 

7. Click on the  Button to clear the data entry form. 

8. Type in a Top and Base Depth into the builder and then click on the  button. 
9. Repeat Steps 7-8 for more intervals. 
10. Once all your test intervals are entered or you have added more test intervals, you want them to come out 

sequentially by depth in the Export Utility you will want to right click on the track to activate the pop out menu 
and select Renumber Tests. 

11. Click on the  button or Press the Esc key on the keyboard to exit from the Core Interval Test Builder 
window. 

Resizing an Interval 
This is only available to Intervals that are not locked with the DS Intervals. 
1. Double click on the Auto Test Interval Calculator track / layer to activate the Core Interval Test Builder 

window. 
2. Move the mouse pointer over the interval to be resized and Click once. This will activate the Builder with the 

depths of the Selected Test Interval 

3. Type in a new top and / or base depth and click on the  button. 

Deleting a Single Interval 
1. Double click on the Auto Test Interval Calculator track / layer to activate the Core Interval Test Builder 

window. To delete an interval it must be pink. If it is grey you will have to change the Lock to Unlock or vice 
versa. 

 
2. Right click anywhere within the interval you wish to delete to activate the pop-up menu. 
3. Click on Delete and the interval will be deleted accordingly. 
4. Repeat Steps 2 and 3 to delete more Core Interval Test from the layer. 
5. Once all your test intervals have been deleted, you will want them to come out sequentially by depth in the Export 

Utility you will want to right click on the track to activate the pop out menu and select Renumber Tests. 

6. Click on the  button or Press the Esc key on the keyboard to exit from the Core Interval Test Builder 
window. 
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Deleting Multiple Intervals 
1. Double click on the Core Test Interval track / layer to activate the Core Interval Test Builder window. To 

delete an interval it must be pink. If it is grey you will have to change the Lock to Unlock or vice versa. 

 
2. Press and Hold the SHIFT Key and then click and drag an area anywhere within the intervals you wish to 

delete. 
3. Release the mouse button to activate a Confirm Multiple Delete message. 

 

4. Click on  button and the Core Interval Test encompassed with your drag will be deleted accordingly. 
5. Once all your test intervals have been deleted, you will want them to come out sequentially by depth in the Export 

Utility you will want to right click on the track to activate the pop out menu and select Renumber Tests. 

6. Click on the  button or Press the Esc key on the keyboard to exit from the Core Interval Test Builder 
window. 

Note: Every type of layer in Power*Log, Power*Core and Power*Curve has a Data Type classification. The default 

settings for the Auto Core Test Interval Selector layer are shown below. To access this window, click on the  
Layer Configuration button on the Toolbar, when the layer is active. 
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Core Photo Magnifier Layer / Track 
This layer enables the user to magnify what is being displayed in the Core Photo Stack layer / track. The Core photos 
are displayed on the stacked layer and the sleeve data can be viewed on the sleeve data display layer. This track is 
automatically added when you add the Core Photo Stack Layer / track and will give you a magnification for the core 
sleeves to zoom in on a particular contact or feature that you wish to magnify without having to change the log 
viewing scale. These photos can be added individually or can be imported by way of an ASCII file with the correct 
information. These layers are only available in Power*Core. 

Right Click Menu Items 
The user has the ability to magnify the Core Photos that are stacked in the Core Photo 
Stack layer / track at any given depth. If you select 1:1 to 1:5 you could also use the 
Log Scale drop box and select or type in the scale you pick from the right click option. 
The difference would be that you would see far less of the rest of your Core Log when 
you change the log scale. 

How to Magnify the Core Photos. 
1. If the Core Photo Magnify Track is not being displayed Right Click on the Core 

Photo Stacking Layer and select the Toggle Magnify View. This will turn on the 
Core Photo Magnify Track. 

 
2. Right Click on the Core Photo Magnify track at a specific depth and select one of the magnify Views. This will 

display the core photos at the scale you selected on this layer. These actions are shown below. 

                        

Note: You will see black ruler style lines on the magnify view. The ruler markings are 1cm divisions to allow the user 
to figure out at what depth the contact or physical structure you wish to identify is located. You will have to utilize the 
depth where you right clicked (red line with blue depth markings) at to help you figure out the location you wish to 
utilize. 

 

Note: You may want to turn on the Mouse Hair Option under the View menu Selection and change you mouse pointer 
accuracy to .05 or .01 to fine tune your right click. 

Core # and Sleeve Data Layer / Track 
This layer displays the Core Photo sleeve data that have been cropped from Core Box photos generated by a 
photographer. The Core photos are displayed on the Core Photo Stack layer and the sleeve data can be viewed on 
the Core # and sleeve data display layer. The layers data only reflects the Core Sleeve Number and whether the core 
is whole or rubble. This data can be exported in an ASCII format for ease of testing or formatting the core photos. 
This layer is only available in Power*Core. 
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How to Add a Core # and Sleeve Data Layer / Track 

1. Click on Log Configuration Builder under the Options menu selection or click on the  Log Configuration 
Builder button on the Toolbar to activate the Log Configuration Builder window: 

 
2. On the left hand side of the Log configuration window scroll down the list of tracks and click on the Core # 

and Sleeve Data track. The track will become highlighted and the Tracks radio button  will become 
activated. 

3. On the right hand side of the Log configuration window click on the Track you want it to go above or to the left of. 
In this example we will be adding the Core # and Sleeve Data track to the left of the Depth Track. The track will 
become highlighted and the Tracks radio button  will become activated. 

4. In the middle of the Log configuration window click on the  button. This will activate a System 
Message asking the user “Do you really want to ADD the selected (TRACK) from the available log to the active 
log?” 

5. Click on the  button. This will activate a Get Name window allowing the user to name the track. 

 

6. Type in a new Track name or keep the existing name and then click on the  button.  The track will be 
added above the Depth Track or to the left on the log, and the Log Configuration Builder window will be shown. 
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7. Click on the  button. This will activate the Log with the new track and you will then 
prompted with the Current Core Photo Group window for the Core Photo Stack layer. Drop the 
Group ID drop box and select an Existing Group or Type in a new Group ID for this layer. 

 
Note: This Core Photo group will be the same for this layer, as well as the Core Photo Stacked layer, Automated 
Dean Starks Calculator, Automated Test Interval Calculator and the Test Point Indictor layers. 
 
This Layer / Track is only a display layer for the Core sleeves that have been stacked in 
the Core Photo Stack layer. It displays the Core # along with the extents of the Core 
along with the sleeve # and the Rubble (green) / Core (blue) Indications. 

Right Click Menu Selections 
Change Group- This selection will allow the user to change the Photo Group 
associated with this layer. If you change it for this layer all the layers associated with 
this group must also be changed. 

Note: When you add any layer to a log, it is always associated with a Data Type. Every data type in Power*Log / 
Core & Curve has a default setting. The default settings for a Core # and Sleeve Data layer are shown below. To 

access this window, click on the  Layer Configuration button on the Toolbar, when the layer is active. 
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Interpreted Facies Layer - Facies Builder 
This Builder will allow you to draft on the Interpreted Facies Layer. The user can utilize this layer if they have the 
Power*Core Module. In a Facies Log this layer will control the entry of all Bed Restricted Layers. If you do not have 
an interval of Interpretive Facies you cannot enter any bed restricted data. Consequently if you resize or delete a 
Facies all bed restricted data will also be affected. 

How to Add an Interpretive Facies Track. 
To fully utilize this track / layer the Log Format type must be Facies Log. 

8. Click on Log Configuration Builder under the Options menu selection or click on the  Log Configuration 
Builder button on the Toolbar to activate the Log Configuration Builder window: 

 
9. On the left hand side of the Log configuration window scroll down the list of tracks and click on the 

Interpretive Facies track. The track will become highlighted and the Tracks radio button  will become 
activated. 

10. On the right hand side of the Log configuration window click on the Track you want it to go above or to the left of. 
In this example we will be adding the Interpretive Facies track to the left of the Depositional Environment Track. 
The track will become highlighted and the Tracks radio button  will become activated. 

11. In the middle of the Log configuration window click on the  button. This will activate a System 
Message asking the user “Do you really want to ADD the selected (TRACK) from the available log to the active 
log?” 
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12. Click on the  button. This will activate a Get Name window allowing the user to name the track. 

 

13. Type in a new Track name or keep the existing name and then click on the  button.  The track will be 
added above the Depositional Environment Track or to the left on the log, and the Log Configuration Builder 
window will be shown. 

 

14. Click on the  button. This will activate the Log with the new track and you will then prompted with the 
Enter New Group for the Interpretive Facies. Drop the Group ID drop box and select and Existing Group or Type 
in a new Group ID for this layer. 

 

Overview of Facies Builder window. 

 
 Button The user can enter the depths into the two depth fields with Facies selected and then click on the  

button. Their interval will now be drawn on the Interpretive Facies Track. 
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 Button: The user can click on an existing interpretive Facies interval and the 

corresponding data will be shown in the builder. The user can then click on the  
button to delete the interval. 

:Check box when activated will prompt the user with a Confirmation 
window Do you really want to delete? If this  is unchecked the Facies 
Interval will be deleted without any system message. 

 This Check box when activated will not allow spaces between beds on the Interpretive Facies Layer 
when you are using the mouse (not the keypad) when entering Lithology Intervals. This function will work if you are 
within ¼” of an existing Interval and will snap to the facies interval already drawn on your log. 

 Button will activate a list of the Interpretive Facies Intervals in your active well. The user can select any 
interval from this list and can then modify or delete this interval. 

 Button allows the user to Add, Change or Delete Existing Facies Fill Types. 
 check box allows the user to turn / off the Text in the drawn facies. 

 check box allows the user to turn / off the Color Fill in the drawn facies. 
 check box allows the user to Display the Long Name of the drawn facies if the Text option is selected. 
 check box allows the user to Display the Name with an Opaque background of the drawn facies if the 

Text option is selected. 

 drop box allows the user to Display the Name of the drawn facies if 
the Text option is selected at the top centre or bottom of the drawn interval. 

 drop box allows the user to Display the Name of the drawn facies if 
the Text option is selected at the left centre or right of the drawn interval. 

 drop box allows the user to Display the Name of the drawn facies if the 
Text option is either vertically or horizontally within the facies. 

 Button will close the Facies builder. 

Right Click Menu Items 
All these menu items are described above as they are part of the Facies Builder as well. 
Once the display is the way you prefer them you will find that every time you work with this 
layer the default will now be the same as when you left the builder. 
Change Group Selection allows the user to switch to a different FACIES group. 

Adding Fill Types to the Interpretive Facies Builder 
1) Double click anywhere within the Interpretive Facies track to activate the Facies Builder window. If no fills 

have been added skip to Step 3. 

 

2) Click on the  button. This will activate the window show below. If the window has a fill already 

displayed and you want to start a new fill then click on the  button to clear the window to add a new facies. 
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3) Type the Facies long name into the Description field. 
4) Type the Facies short name into the Short Name field. 
5) Click on the  button and select a color from the palette and then click on the  button. 
6) Click on the  button and select a color from the palette and then click on the  button. 
7) Click on the Gradient  to activate a check mark if you want the gradient option. 
8) Click on the Pattern field box arrow to select a specific pattern type. 
9) Pick a sampling type from the drop box. 
10) Type in a Sample Code. This is a secondary display on the Name when displayed on the Facies Interval. 
11) Type in a Sample Size (optimum) Minimum and Maximum sample size in the fields provided for the 

Automated Dean Stark Calculator layer / track to work with in the automation process. These sizes are in cm’s (1 
meter = 100 cm). 

12) Type in the Lost Core Maximum Value for the Automation for sampling to be straddled over. 

13) Click on the  button or press ALT-S. The Shortcut Options window will be shown. 

 

14) To enter another Fill for Facies, click on the  button and repeat Steps 3 to 13 OR 

15) Select  from the ensuing Shortcut Options window. This will exit the window and the new Facies has 
been added. 

Editing Interpretive Facies Fill Types 
1. Double click anywhere within the Interpretive Facies track to activate the Facies Builder window. 

  

2. Click on the Facies drop box and select the fill to be edited. 

3. Click on the button. Your selection will be shown in the Fill Type window. 
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4. Make the necessary changes and click on the  button. The Shortcut Options window will be shown.  

 

5. Select  from the ensuing Shortcut Options window. This will clear the window and allow the user to edit 
a new record. 

Deleting Facies Fill Types 
1. Double click anywhere within the Interpretive Facies track to activate the Facies Builder window. 

 
2. Click on the drop box arrow in the Facies window and select any of the Facies from the resulting choice list that 

you would like to delete. 

3. Click on the button, and the Fills for ‘Environment’ window will be shown. 
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4. Click on the  button, and the Warning window will be activated. 

 

5. Click on the  button, and the Confirmation window will be activated 

 

6. Click on the  button, and the Facies will be deleted. 

Drafting an Interpreted Facies Interval 

1. Double click anywhere within the Interpreted Facies track to activate the Facies Builder window. 

 
2. Select a Facies. There are 3 ways to select a Facies Fill, some faster than others. 
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 The user can right click anywhere within the Interpretive Facies track to activate the pop-up menu 
shown below. Then select by clicking once on the desired Facies from the pop-up menu.  

 The user can select a Facies from the Facies field within the Facies Builder window. 
 The user can also click on a previously drawn Facies that is the same as you wish to draw with. If 

done correctly the selected Facies will be automatically displayed in the Facies field within the Facies 
Builder window. 

 
3. Click and drag up or down within a specific track to define the Facies interval. Or, If there is a Facies defined 

above and below (within 100 meters) and you want to fill in the interval simply double click in the interval and it 
will fill in. 

Note: This can be done on any track but more often than not the Interpretive Lithology Track is the most convenient. 
With the  activated the Facies being drawn will snap to the previous Facies either above or below 
depending on your drag if you are within ¼” of already drawn lithology. 

4. Release the mouse button and the interval will be drawn accordingly. 

Inserting a Facies within an existing Facies 

You are able to insert thinner Facies of a different Facies Type into an existing Facies. This prevents you from 
having to re-enter the properties of the main Facies above and beneath the inserted thinner Facies. 
1. Double click anywhere within the Interpreted Facies track to activate the Facies Builder window. 
2. Select a Facies type. There are 3 ways to select a Facies Fill. 

 The user can right click anywhere within the Interpretive Facies track to activate the pop-up menu 
and mouse over the Fills Menu item. Then select by left clicking once on the desired Facies Fill from 
the pop-up menu.  

 The user can select a Facies from the Facies field within the Facies Builder window. 
 The user can also click on a previously drawn Facies that is the same as you wish to draw with. 

3. If done correctly the selected Facies will be automatically displayed in the Facies field within the Facies Builder 
window. 

4. Click and drag the mouse button up or down within a specific track to define the Facies interval. 
5. Release the mouse button, and you will be prompted with a message asking, “Do you want to add an 

interbedded interval?” 

6. Click on the  button and the thinner bed will be drawn accordingly. 
7. Press the Esc key on the keyboard to exit from the Rock Type Builder window. 

Resizing an Existing Facies Fill 
1. Double click on the Interpreted Facies track to activate the Facies Builder window. 
2. Press and hold the Ctrl key on the keyboard down, while moving the mouse pointer over the Facies Fill 

boundary you wish to resize, the mouse pointer will turn into a resize , (remember if two Fills are touching to 
look into the builder to see if you have the correct one selected) 

3. Clicking and dragging the left mouse button up or down the Interpreted Facies track to either shrink or 
enlarge the selected interval. 

Note: You are not allowed to overlap an existing facies entirely and if you attempt to do so, you will receive an 
"Unsupported Add Sequence" system message. 

4. Release the mouse button at the desired depth, followed by the release of the Ctrl key on the keyboard, and the 
following system message will be activated, “Do you really want to RESIZE the interval from _ to _ ?” 
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Note: Resizing a Facies will result in a resizing its associated bed restricted description category information, i.e. 
Grain Size, Porosity Grade, and so on. 

5. Press the Esc key on the keyboard to exit from the Facies Builder window. 

Deleting a Single Facies Fill. 
1. Double click on the Interpreted Facies track to activate the Facies Builder window. 
2. Right click anywhere within the Interpreted Facies track to activate the pop-up menu. 
3. Click on Delete and the following system message will be activated, “Do you really 

want to DELETE _ to _ ?” Click on the  button to confirm the deletion. 

Note: When you delete a Facies Fill, you will also delete its associated bed restricted rock 
description information, i.e. Grain Size, Porosity Grade, Type, Oil Show and all other bed 
restricted data. 

4. Press the Esc key on the keyboard to exit from the Facies Builder window. 

Deleting a Multiple Facies Fills 
1. Double click on the Interpreted Facies track to activate the Facies Builder window. 
2. Hold the SHIFT Key down and then click and drag anywhere within the Interpreted 

Facies track and then let go of the Shift Key and left mouse button. This will activate a Delete Intervals 
message box. 

 

3. Click on  button and the Intervals dragged over will be deleted. 

Note: When you delete a Facies Fill, you will also delete its associated bed restricted rock description information, 
i.e. Grain Size, Porosity Grade, Type, Oil Show and all other bed restricted data. 

4. Press the Esc key on the keyboard to exit from the Rock Type Builder window. 
 
Note: Every type of layer in Power*Log/Curve has a Data Type classification. The default settings for the 

Interpreted Facies layer are shown below. To access this window, click on the  Layer Configuration button on 
the Toolbar, when the Interpreted Lithology layer is active. 
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Interpretive Lithology Layer / Track 
Added the ability to Insert Lithology to a Facies. If an Interpretive Facies has been inserted the user can now CTRL 
Key depressed and double click with the mouse to fill in a selected rock type into the top and base depths of the 
preexisting Facies. 

Added an  button into the builder to be able to select small beds that get entered and are not really 
visible. You can now select them from a list and delete them from the builder. 
Added the Ability to Delete Multiple Rock / Bed Intervals. 

 

Deleting Multiple Rock Types or Beds 
1. Double click on the Interpreted Lithology track to activate the Rock Type Builder window. 
2. Hold the SHIFT Key down and then click and drag anywhere within the Interpreted Lithology track and then 

let go of the Shift Key and left mouse button. This will activate a Delete Intervals message box. 

 

3. Click on  button and the Intervals dragged over will be deleted. 

Note: When you delete a Rock Type, you will also delete its associated bed restricted rock description information, 
i.e. Grain Size, Porosity Grade, Type, Oil Show and all other bed restricted data. 

4. Press the Esc key on the keyboard to exit from the Rock Type Builder window. 
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Percent Layer 
Percent can be added either as a track or a layer to your log. When you add a Percent as a layer to your log, 
you must assign it to a specific track. 

How to Add a Percent Track / Layer 

1. Click on Log Configuration Builder under the Options menu selection or click on the  Log Configuration 
Builder button on the Toolbar to activate the Log Configuration Builder window: 

 
2. On the left hand side of the Log configuration window scroll down the list of tracks and click on the Percent 

track. The track will become highlighted and the Tracks radio button  will become activated. 
3. On the right hand side of the Log configuration window click on the Track you want it to go above or to the left 

of. In this example we will be adding the Percent track to the left of the Depth track or above the Depth track in 
the horizontal application. The track will become highlighted and the Tracks radio button  will become 
activated. 

4. In the middle of the Log configuration window click on the  button. This will activate a System Message 
asking the user “Do you really want to ADD the selected (TRACK) from the available log to the active log?” 

5. Click on the  button. This will activate a Get Name window allowing the user to name the track. 

 

6. Type in a percent name and then click on the  button.  The track will be added above the Depth 
Track or to the left on the log, and the Log Configuration Builder window will be shown. 

 

7. Click on the  button. This will activate the Log, and the new track will be added to your log. 
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The User can now Import Percent data from an ASCII file. To access the import 
utility you can right click on the layer and select the Import Percent Data from 
the pop out menu or you can use the File Menu illustrated to the right or click on 

the Import  Icon on the Import Toolbar. 

Right Click Menu Items 

Import Percent Data Selection will open the Import 
Utility. 
Scale Selection will activate the Scale and Units 
window to the user can change the scale. 
Change Data Group Selection will allow the user to 

select a different data group to show on this layer. 

Right Click Menu Items with the builder Open 

Delete Selection will delete the data where the user 
has right clicked. You can also delete the data in the Data Entry window. 
Delete All Selection will allow the user to delete all the data. You will not be able to 
recover the data if you do select this option. 
Scale Change Selection will activate the Layer Configuration window, Layer Scales Tab 
and fill in the left and right scales that fit your requirements. 
Soft Edge Selection will change the fill from squared off blocks to wavy rounded blocks. 
Hard Edge Selection will change the fill from wavy rounded blocks to squared off blocks. 
Line Width Selection will allow the user to change the line width if Point to Point is 
activated. 

Drawing Percent Data (Mouse Pointer Method) 

1. Double click on the Percent track to activate the Percent Layer window. 

                
 The default is a black histogram. The user has the ability to modify this. 

2. Click on the  button and select a color from the palette and then click on the  button. 

3. Click on the  button and select a color from the palette and then click on the  button. 
4. Click on the Gradient  to activate a check mark if you want the gradient option. 
5. Click on the Pattern field box arrow to select a specific pattern type. 
6. Click on the Snap to field box arrow in the Fills for Environment window and select any of the percent from the 

resulting choice list. This allows the mouse to move or less precision when dragging in a percentage. 
7. Soft Edges : When checked will round off the percent and will present the percent edges with sine wave 

lines instead of strain lines. 
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 Percent Hard edges Percent Soft edges 

8. Click on the  button.  
9. Define the desired interval by clicking and dragging the mouse pointer from a specific Measured Depth and 

Percent (%), as indicated within the mouse pointer display box to another Measured Depth on the Percent (%) 
track. 

10. Release the mouse button and the percent interval will be drawn accordingly. 
11. Repeat steps 8-9 to define more intervals. 

12. Click on the  button to exit the window. 

Drawing Percent Data (Keypad Method) 

1. Double click on the Percent track to activate the Percent Layer window. 

 

2. Click on the  button. This will activate the Data Entry window. 
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3. Double Click in the Top Depth Field and type in a top depth. Depress the Tab Key. 
4. Type in a base depth in the Base Depth Field. Depress the Tab Key. 
5. Type in a percent Value in the Value field. 
6. Click  button or the Enter key on your keypad and the data will be entered. 
7. Repeat Steps 3-6 to enter more percent data. 

8. Click on the  button to exit the data editor and Save the data. 

Deleting Percent Entry (Mouse Pointer method) 

1. Double click on the Percent track to activate the Percent Layer window. 

 
2. Right click on the interval within the Percent track that you want to delete and select Delete from the pop out 

menu. The interval will be deleted. To delete all the intervals select Delete All Data instead. 
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3. Click on the  button and the Percent Layer window will be closed. 

Deleting Percent Data (Keypad Method) 

1. Double click on the Percent track to activate the Percent Layer window. 

 

2. Click on the  button. This will activate the Data Entry window. 

 
3. Click the line of data you wish to delete. The user can use the SHIFT key to select a range of data and the 

CTRL key to pick more than one data line with the aid of the mouse click. 
4. Click  button and the data will be deleted. 
5. Repeat Steps 3-4 to delete more percent data. 
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6. Click on the  button to exit the data editor and Save the data. 

Changing the Percent Scale 

Percent scale can be changed through the Layer Configuration window or the user can utilize the right click pop 
out menu item. 

1. Click on the  Layer Configuration button on the Toolbar, when the Percent layer is active. This will 
activate the Layer Configuration window. 

2. Click on the Layer Scales Tab to show the window shown below. 

 
3. Notice that the default scale (when the percent was originally added to the log) was 0 to 100% as you would see 

in your window. To change the original scale from 0 – 100% to 0 – 20%, simply adjust the Left Scale value to 40 
by double clicking in the Left Scale field and typing in a value of 420. 

4. The user can also change the layer grid pattern by changing the Linear Cycles portion of the window. 

5. Click on the  button and select  from the System Message window to exit the Layer 
Configuration window. 

Note: Every type of layer in Power*Log, Power*Core and Power*Curve has a Data Type classification. The default 

settings for the Generic Category are shown below. To access this window, click on the  Layer Configuration 
button on the Toolbar, when the Percent layer is active. 
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Test Point Indicator Layer / Track 
This layer allows the user to indicate other Test points. The layer is only available with our Power*Core application 
Version 2015 and beyond. The User can also enter in the data by mouse pointer or keypad methods. 

How to Add a Test Point Track 

1. Click on Log Configuration Builder under the Options menu selection or click on the  Log Configuration 
Builder button on the Toolbar to activate the Log Configuration Builder window: 

 
2. On the left hand side of the Log configuration window scroll down the list of tracks and click on the Test 

Point Indicator track. The track will become highlighted and the Tracks radio button  will become 
activated. 

3. On the right hand side of the Log configuration window click on the Track you want it to go above or to the left of. 
In this example we will be adding the Test Point Indicator track to the left of the Grains Size Track. The track will 
become highlighted and the Tracks radio button  will become activated. 

4. In the middle of the Log configuration window click on the  button. This will activate a System 
Message asking the user “Do you really want to ADD the selected (TRACK) from the available log to the active 
log?” 

5. Click on the  button. This will activate a Get Name window allowing the user to name the track. 

 
6. Type in a new Track name or keep the existing name and then click on the  button.  The track will be 

added above the Grain Size Track or to the left on the log, and the Log Configuration Builder window will be 
shown. 
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7. Click on the  button. This will activate the Log with the new track 

Entering Test Points (Mouse Pointer Method) 

1. Double click on the Test Point Indicator track / layer to activate the Core Point Test Builder window. 

 
2. Double Click anywhere on the Core Point Test Indicator track / layer to initiate a test point. The test point will 

be drawn with a line the layer name and a depth. 

  
3. Once all your test points are entered or you have added more test points, you want them to come out 

sequentially by depth in the Export Utility you will want to right click on the track to activate the pop out menu 
and select Renumber Tests. 

4. Click on the  button or Press the Esc key on the keyboard to exit from the Core Point Test Builder 
window. 

Entering Test Points (Key Pad Method) 

1. Double click on the Core Point Indicator track / layer to activate the Core Point Test Builder window. 
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2. Click on the  button and Type in a Value in the Depth field. 

3. Click on the  button. 
4. Repeat Steps 2-3 to enter more Test point data. 

  
5. Once all your test points are entered or you have added more test points, you want them to come out 

sequentially by depth in the Export Utility you will want to right click on the track to activate the pop out menu 
and select Renumber Tests. 

6. Click on the  button or Press the Esc key on the keyboard to exit from the Core Point Test Builder 
window. 

Deleting a Single Interval 

1. Double click on the Test Point Indicator track / layer to activate the Core Point Test Builder window 

 
2. Right click on the red X indicating the Test point to activate the Pop out menu and select Delete. 

3. OR the User can also type in a corresponding value in the builder and click on the  button. 
4. Repeat Steps 2 to delete more Core Point Test from the layer. 
5. Once all your test points are entered or you have added more test points, you want them to come out 

sequentially by depth in the Export Utility you will want to right click on the track to activate the pop out menu 
and select Renumber Tests. 

6. Click on the  button or Press the Esc key on the keyboard to exit from the Core Point Test Builder 
window. 

Deleting Multiple Intervals 

1. Double click on the Core Point Indicator track / layer to activate the Core Point Test Builder window. 

 
2. Press and Hold the SHIFT Key and then click and drag an area anywhere within the intervals you wish to 

delete. 
3. Release the mouse button to activate a Confirm Multiple Delete message. 

 

4. Click on  button and the Core Point Test encompassed with your drag will be deleted accordingly. 
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5. Once all your test points are deleted, you want them to come out sequentially by depth in the Export Utility you 
will want to right click on the track to activate the pop out menu and select Renumber Tests. 

6. Click on the  button or Press the Esc key on the keyboard to exit from the Core Point Test Builder 
window. 

Note: Every type of layer in Power*Log, Power*Core and Power*Curve has a Data Type classification. The default 

settings for the Core Test Point Indicator layer are shown below. To access this window, click on the  Layer 
Configuration button on the Toolbar, when the layer is active. 

 

V Shale GR Layer 
V Shale GR layer will calculate the V shale from all the different calculation methods available if using a 
normal Gamma Ray curve. This will utilize an existing GR Curve that has to be available from preexisting 
data. 

How to Add a V Shale (GR) Track / Layer 

1. Click on Log Configuration Builder under the Options menu selection or click on the  Log Configuration 
Builder button on the Toolbar to activate the Log Configuration Builder window: 
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On the left hand side of the Log configuration window scroll down the list of tracks and click on the V Shale 
(GR) track. The track will become highlighted and the Tracks radio button  will become activated. 

2. On the right hand side of the Log configuration window click on the Track you want it to go above or to the left 
of. In this example we will be adding the Vshale (GR) track to the left of the Core Photo Stack track. The track 
will become highlighted and the Tracks radio button  will become activated. 

3. In the middle of the Log configuration window click on the  button. This will activate a System 
Message asking the user “Do you really want to ADD the selected (TRACK) from the available log to the active 
log?” 

4. Click on the  button. This will activate a Get Name window allowing the user to name the track. 

 

5. Type in a new name if you like and then click on the  button. The track will be added above the 
Core Photo Stack Track or to the left on the log, and the Log Configuration Builder window will be shown. 

 

6. Click on the  button. This will activate the Log, and the new track will be added to your log and will 
also activate the Curve List Selection for V Shale calculations window. This will be a list of all the curves you 
have in your database under the wells UWI. 
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7. Highlight the GR Curve you want to use and click on the  button. This will activate the V Shale 
Options Window. 

 

8. Type in your appropriate Values and then Click on the  button to finish adding the track. 

Right Click Menu Items 

Right click on the V Shale GR layer to activate the pop-out menu. The active layers 
Curve Name is displayed in the upper portion of the pop-out menu. 
Select Gamma Ray Source Selection activates the Curve List Selection for V Shale 
Calculations and allows the user to select a different the GR Curve for the application to 
calculate from. 
V Shale Options Selection activates the V Shale Options window so the user can see 
or change the Min and Max values for Clean GR and Shale GR counts. 
Calculation Method Selection allows the user to Change the GR calculations. 
V Shale Formulas Show below. 

   

   
Line Width Selection indicates the width of the curve in pixels. To change the line width, right click on an active 
curve layer, move the mouse pointer over the Line Width selection and clicking on a new width. 
Line Pattern Selection indicates the pattern of the curve. To change the line pattern, 
right click on an active curve layer, move the mouse pointer over the Line Pattern 
selection and click on a new line pattern 

PtoP point to point curve (stops curve at null values) 
PtoP2 point to point curve (disregards null values [continuous 

curve]) 
Box histogram or box curve (stops curve at null values) 
Box2 histogram or box curve (disregard nulls values [continuous 

curve]) 
Track Fill fills track with color determined in the pgeology32.ini 
Histogram draws a colored histogram the width of the line width from 

the data point back to the lowest value track edge. 
Point Only shows only the data points and defaults to circles if nothing 

defined in the point indicator portion of curve definitions 
Line Style Selection indicates the associated with the curve. This field is changed by 
right clicking on an active curve layer, moving the mouse pointer over the Line Style 
selection and clicking on a new Selection. 
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Line Color Selection indicates the line color associated with the curve. To change the line color right click on an 
active curve layer, move the mouse pointer over the Line Color selection and click on a new line color. 

                        
Scale Selection enables the user to get quickly at the curve scales for the active curve. Then, the user can change, 
add or delete existing scales in the Curve Scales window. 

 

Notice that the Depth Interval (From) and Interval (To) values, respectively, have defaulted to "0" to "0" with the 
Scale (Left), Scale (Right), and Backup Scale defaulting to the values last entered by the user. An interval of 0 to 0 
represents the entire Depth Interval for the curve. 

Editing a Curve Scale 

Note: There are many ways to access Curve Scale window, the user can right click on the active layer shown above, 
access it from the Curve Editor window, access it through the curve layer window, access it through the well window. 

1. Select the appropriate depth interval you wish to change by scrolling through the records using the database 
navigational button or click on the Depth Interval Button and selecting the appropriate depth interval by double 
clicking on it. 

2. Enter a new value into the Left / Bottom and or Right / Top scale values. 



                                Addendum Manual 2015 
 

Addendum Manual 2015, page 64 

3. Click on the  button or press ALT-S and select the  button from the ensuing Shortcut Options 
window. 

4. Click on the  button or press ALT-S and then click on the appropriate button when prompted with the 
Shortcut Options system window. 

The Show Values Selection draws the values of the data points on the layer. 

                                             
The Value Orientation Selection indicates where the values will be 
drawn on the layer 
The Point Indicators Selection indicates where the data points on the 
curve are being drawn with. This field is changed by right clicking on 
an active curve layer, moving the mouse pointer over the Point 
Indicators selection and clicking on any of the pop out menu 
selections. If point indicators are turned on these will also presented in 
the Track header. 
The Edit Curve Selection allows the user to view and change the 
digital Curve attributes as well as access the scale. 

 

Changing Digital Curve Attributes (Units / Null Value) 
You can use the Layer Configuration window to edit Curve Units, Scales, Colors, and Styles. The User can 
also edit the Curve attributes in the Well Window. The User can also right click on the layer and select Edit 
Options. 

1. If the curve layer is active right click on the layer to activate the pop out menu and select Edit Curve. 
2. You can now select (or type in), new units, change the null value, or add/change the remarks. 

3. Click on the  button or press ALT-S and then click on the  button when prompted with the 
Shortcut Options system window. 

Open Curve Average Window Selection allows the user to determine the curve average, median or mode over a 
depth interval. 
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1. If the curve layer is active right click on the layer to activate the pop out menu and select Open Curve 
Average Window. This will activate the window shown below. 

             
2. Click on the appropriate radio button  to determine what you want to calculate. 

 Average = is the quotient obtained by dividing the sum total of a set of figures by the number of figures. 
 Median = applies to the value that represents the point at which there are as many instances above as 

there are below. 
 Mode = the most frequent value of a set of data. 

3. Define the top and base depths by typing in their depths or clicking and dragging an interval on the log. 

4. Click on the  button and the result will be displayed under the Curve name field. If mode was selected 
then the mode is displayed and the frequency is displayed in the field under the mode radio button. 

Scale Text Orientation Selection allows the user to change the scale text in the main body of the log from a Vertical 
Orientation to a Horizontal Orientation. 

Note: Every type of layer in Power*Log, Power*Core and Power*Curve has a Data Type classification. The default 

settings for the Vshale (GR) layer are shown below. To access this window, click on the  Layer Configuration 
button on the Toolbar, when the Vshale (GR) layer is active. 
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V Shale Porosity (Por) Layer 
V Shale Porosity (Por) layer will calculate the V shale from the different calculation methods from the 
Neutron Density Cross plots. This will utilize the existing Neutron and Density log data that has to be 
available from preexisting data. 

How to Add a V Shale Porosity (Por) Track / Layer 

1. Click on Log Configuration Builder under the Options menu selection or click on the  Log Configuration 
Builder button on the Toolbar to activate the Log Configuration Builder window: 

 
On the left hand side of the Log configuration window scroll down the list of tracks and click on the V Shale 
(Por) track. The track will become highlighted and the Tracks radio button  will become activated. 

2. On the right hand side of the Log configuration window click on the Track you want it to go above or to the left 
of. In this example we will be adding the Vshale (Por) track to the left of the Core Photo Stack track. The track 
will become highlighted and the Tracks radio button  will become activated. 

3. In the middle of the Log configuration window click on the  button. This will activate a System 
Message asking the user “Do you really want to ADD the selected (TRACK) from the available log to the active 
log?” 

4. Click on the  button. This will activate a Get Name window allowing the user to name the track. 

 

5. Type in a new name if you like and then click on the  button. The track will be added above the 
Core Photo Stack Track or to the left on the log, and the Log Configuration Builder window will be shown. 



Addendum Manual 2015 

Addendum Manual 2015, page 67 

 

6. Click on the  button. This will activate the Log, and the new track will be added to your log and will 
also activate the V Shale Porosity Options Window. 

 

7. Click on the  buttons beside the Neutron Porosity and then Density Porosity display field to activate the 
Curve List Selection for V Shale Porosity calculations window. This will be a list of all the curves you have in your 
database under the wells UWI. 

          

8. Highlight the Neutron Curve you want to use and click on the  button. Repeat the steps to pick 
the Density Porosity Curve. This will fill in the V Shale Options Window. 

9. Determine if the values in the Neutron / Density Curves are fractional (0.231) or percentage (23.1) and 
uncheck the fractional check box if percentage data. 
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10. Type in your appropriate default Values. 
11. Depending on your layers scales 0 to 100 you would check the output in percentage 

checkbox and if you scales are 0 to 1 then uncheck the output in Percentage check box. 

12. Click on the  button to finish adding the track. 

Right Click Menu Items 

Right click on the V Shale Por layer to activate the pop-out menu. The active layers Name is 
displayed in the upper portion of the pop-out menu. 
V Shale Options Selection activates the V Shale Porosity Options window so the user can see 
or change the curves and the density and neutron readings for shale shown above. 
The Calculation Method V Shale Formulas Shown below. 
Vshxnd = (PHIN - PHID) / (PHINSH - PHIDSH) where: 
   PHIN = Neutron log reading 
   PHID = Density log reading 
   PHINSH = Neutron log reading in 100% shale 
   PHIDSH = log reading in 100% shale 
Line Width Selection indicates the width of the curve in pixels. To change the line width, right click on an active 
curve layer, move the mouse pointer over the Line Width selection and clicking on a new width. 
Line Pattern Selection indicates the pattern of the curve. To change the line pattern, 
right click on an active curve layer, move the mouse pointer over the Line Pattern 
selection and click on a new line pattern 

PtoP point to point curve (stops curve at null values) 
PtoP2 point to point curve (disregards null values [continuous 

curve]) 
Box histogram or box curve (stops curve at null values) 
Box2 histogram or box curve (disregard nulls values [continuous 

curve]) 
Track Fill fills track with color determined in the pgeology32.ini 
Histogram draws a colored histogram the width of the line width from 

the data point back to the lowest value track edge. 
Point Only shows only the data points and defaults to circles if nothing 

defined in the point indicator portion of curve definitions 
Line Style Selection indicates the associated with the curve. This field is changed by 
right clicking on an active curve layer, moving the mouse pointer over the Line Style 
selection and clicking on a new Selection. 
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Line Color Selection indicates the line color associated with the curve. To change the line color right click on an 
active curve layer, move the mouse pointer over the Line Color selection and click on a new line color. 

                        
Scale Selection enables the user to get quickly at the curve scales for the active curve. Then, the user can change, 
add or delete existing scales in the Curve Scales window. 

 

Notice that the Depth Interval (From) and Interval (To) values, respectively, have defaulted to "0" to "0" with the 
Scale (Left), Scale (Right), and Backup Scale defaulting to the values last entered by the user. An interval of 0 to 0 
represents the entire Depth Interval for the curve. 

Editing a Curve Scale 

Note: There are many ways to access Curve Scale window, the user can right click on the active layer shown above, 
access it from the Curve Editor window, access it through the curve layer window, access it through the well window. 

1. Select the appropriate depth interval you wish to change by scrolling through the records using the database 
navigational button or click on the Depth Interval Button and selecting the appropriate depth interval by double 
clicking on it. 

2. Enter a new value into the Left / Bottom and or Right / Top scale values. 

3. Click on the  button or press ALT-S and select the  button from the ensuing Shortcut Options 
window. 

4. Click on the  button or press ALT-S and then click on the appropriate button when prompted with the 
Shortcut Options system window. 
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The Show Values Selection draws the values of the data points on the layer. 

                  
The Value Orientation Selection indicates where the values will be drawn on the layer 
The Point Indicators Selection indicates where the data points on the curve are being drawn with. This field is 
changed by right clicking on an active curve layer, moving the mouse pointer over the Point Indicators selection and 
clicking on any of the pop out menu selections. If point indicators are turned on these will also presented in the Track 
header. 
The Edit Curve Selection allows the user to view and change the digital Curve attributes as well as access the scale. 

 

Changing Digital Curve Attributes (Units / Null Value) 
You can use the Layer Configuration window to edit Curve Units, Scales, Colors, and Styles. The User can 
also edit the Curve attributes in the Well Window. The User can also right click on the layer and select Edit 
Options. 

1. If the curve layer is active right click on the layer to activate the pop out menu and select Edit Curve. 
2. You can now select (or type in), new units, change the null value, or add/change the remarks. 

3. Click on the  button or press ALT-S and then click on the  button when prompted with the 
Shortcut Options system window. 

Open Curve Average Window Selection allows the user to determine the curve average, median or mode over a 
depth interval. 

1. If the curve layer is active right click on the layer to activate the pop out menu and select Open Curve 
Average Window. This will activate the window shown below. 
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2. Click on the appropriate radio button  to determine what you want to calculate. 

 Average = is the quotient obtained by dividing the sum total of a set of figures by the number of figures. 
 Median = applies to the value that represents the point at which there are as many instances above as 

there are below. 
 Mode = the most frequent value of a set of data. 

3. Define the top and base depths by typing in their depths or clicking and dragging an interval on the log. 

4. Click on the  button and the result will be displayed under the Curve name field. If mode was selected 
then the mode is displayed and the frequency is displayed in the field under the mode radio button. 

Scale Text Orientation Selection allows the user to change the scale text in the main body of the log from a Vertical 
Orientation to a Horizontal Orientation. 

Note: Every type of layer in Power*Log, Power*Core and Power*Curve has a Data Type classification. The default 

settings for the Vshale (Por) layer are shown below. To access this window, click on the  Layer Configuration 
button on the Toolbar, when the Vshale (Por) layer is active. 
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V Shale Min Layer 
V Shale Min layer will calculate the V shale minimum from the two different calculation methods from the V 
Shale Por from the Neutron Density Cross plots and the V Shale GR. This will utilize the existing V Shale GR 
(that you calculated) and the V Shale Por (that you calculated) that has to be available from preexisting data. 

How to Add a V Shale (Min) Track / Layer 

1. Click on Log Configuration Builder under the Options menu selection or click on the  Log Configuration 
Builder button on the Toolbar to activate the Log Configuration Builder window: 

 
On the left hand side of the Log configuration window scroll down the list of tracks and click on the V Shale 
Minimum track. The track will become highlighted and the Tracks radio button  will become activated. 

2. On the right hand side of the Log configuration window click on the Track you want it to go above or to the left 
of. In this example we will be adding the Vshale Minimum track to the left of the Core Photo Stack track. The 
track will become highlighted and the Tracks radio button  will become activated. 

3. In the middle of the Log configuration window click on the  button. This will activate a System 
Message asking the user “Do you really want to ADD the selected (TRACK) from the available log to the active 
log?” 

4. Click on the  button. This will activate a Get Name window allowing the user to name the track. 

 

5. Type in a new name if you like and then click on the  button. The track will be added above the 
Core Photo Stack Track or to the left on the log, and the Log Configuration Builder window will be shown. 
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6. Click on the  button. This will activate the Log, and the new track will be added to your log and will 
also activate the V Shale Minimum Options Window. 

 

7. Click on the  button beside the V Shale Gamma and then the V Shale Porosity display field to activate the 
Curve List Selection for V Shale Minimum calculations window. This will be a list of all the curves you have in 
your database under the wells UWI. 

          

8. Highlight the V Shale GR Curve you want to use and click on the  button. Repeat the steps to pick 
the V Shale Por Curve. This will activate the V Shale Options Window. 

 

9. Click on the  button to finish adding the track. 

Right Click Menu Items 

Right click on the V Shale Minimum layer to activate the pop-out menu. The active layers 
Name is displayed in the upper portion of the pop-out menu. 
V Shale Options Selection activates the V Shale Minimum Options window so the user can see 
or change the curves for the Minimum values for V Shale shown above. 
Line Width Selection indicates the width of the curve in pixels. To change the line width, right 
click on an active curve layer, move the mouse pointer over the Line Width selection and 
clicking on a new width. 
Line Pattern Selection indicates the pattern of the curve. To change the line pattern, 
right click on an active curve layer, move the mouse pointer over the Line Pattern 
selection and click on a new line pattern 

PtoP point to point curve (stops curve at null values) 
PtoP2 point to point curve (disregards null values [continuous 

curve]) 
Box histogram or box curve (stops curve at null values) 
Box2 histogram or box curve (disregard nulls values [continuous 

curve]) 
Track Fill fills track with color determined in the pgeology32.ini 
Histogram draws a colored histogram the width of the line width from 

the data point back to the lowest value track edge. 
Point Only shows only the data points and defaults to circles if nothing 

defined in the point indicator portion of curve definitions 
Line Style Selection indicates the associated with the curve. This field is changed by right clicking on an active curve 
layer, moving the mouse pointer over the Line Style selection and clicking on a new Selection. 
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Line Color Selection indicates the line color associated with the curve. To change the line color right click on an 
active curve layer, move the mouse pointer over the Line Color selection and click on a new line color. 

                        
Scale Selection enables the user to get quickly at the curve scales for the active curve. Then, the user can change, 
add or delete existing scales in the Curve Scales window. 

 

Notice that the Depth Interval (From) and Interval (To) values, respectively, have defaulted to "0" to "0" with the 
Scale (Left), Scale (Right), and Backup Scale defaulting to the values last entered by the user. An interval of 0 to 0 
represents the entire Depth Interval for the curve. 

Editing a Curve Scale 

Note: There are many ways to access Curve Scale window, the user can right click on the active layer shown above, 
access it from the Curve Editor window, access it through the curve layer window, access it through the well window. 

1. Select the appropriate depth interval you wish to change by scrolling through the records using the database 
navigational button or click on the Depth Interval Button and selecting the appropriate depth interval by double 
clicking on it. 

2. Enter a new value into the Left / Bottom and or Right / Top scale values. 

3. Click on the  button or press ALT-S and select the  button from the ensuing Shortcut Options 
window. 

4. Click on the  button or press ALT-S and then click on the appropriate button when prompted with the 
Shortcut Options system window. 
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The Show Values Selection draws the values of the data points on the layer. 

                  
The Value Orientation Selection indicates where the values will be drawn on the layer 
The Point Indicators Selection indicates where the data points on the curve are being drawn with. This field is 
changed by right clicking on an active curve layer, moving the mouse pointer over the Point Indicators selection and 
clicking on any of the pop out menu selections. If point indicators are turned on these will also presented in the Track 
header. 
The Edit Curve Selection allows the user to view and change the digital Curve attributes as well as access the scale. 

                           

Changing Digital Curve Attributes (Units / Null Value) 
You can use the Layer Configuration window to edit Curve Units, Scales, Colors, and Styles. The User can 
also edit the Curve attributes in the Well Window. The User can also right click on the layer and select Edit 
Options. 

1. If the curve layer is active right click on the layer to activate the pop out menu and select Edit Curve. 
2. You can now select (or type in), new units, change the null value, or add/change the remarks. 

3. Click on the  button or press ALT-S and then click on the  button when prompted with the 
Shortcut Options system window. 

Open Curve Average Window Selection allows the user to determine the curve average, median or mode over a 
depth interval. 

1. If the curve layer is active right click on the layer to activate the pop out menu and select Open Curve 
Average Window. This will activate the window shown below. 
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2. Click on the appropriate radio button  to determine what you want to calculate. 

 Average = is the quotient obtained by dividing the sum total of a set of figures by the number of figures. 
 Median = applies to the value that represents the point at which there are as many instances above as 

there are below. 
 Mode = the most frequent value of a set of data. 

3. Define the top and base depths by typing in their depths or clicking and dragging an interval on the log. 

4. Click on the  button and the result will be displayed under the Curve name field. If mode was selected 
then the mode is displayed and the frequency is displayed in the field under the mode radio button. 

Scale Text Orientation Selection allows the user to change the scale text in the main body of the log from a Vertical 
Orientation to a Horizontal Orientation. 

Note: Every type of layer in Power*Log, Power*Core and Power*Curve has a Data Type classification. The default 

settings for the Vshale Minimum layer are shown below. To access this window, click on the  Layer 
Configuration button on the Toolbar, when the Vshale Minimum layer is active. 
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Core Photo Profile Tool Module 
This module allows the user to specify the cropping area of a Core photo. This could be the upper 4 core sleeves in a 
set of 8 sleeves, the lower 4 core sleeves in a set of 8 or all 8 sleeves in the core photo. Once the core photo areas 
are profiled this information will be passed along with the Core photo, along with the top and base depths of the core 
and the core recovery to insert the cropped core photos into the Core Log in the Stacked Core Photo layer. 
 

Operating Procedures 

1. Click on the  button, select Programs, select POWER*SUITE_2015. Then, select Utilities and 
click on the Core Photo Profile Tool selection, or if you are in the applications select Core Photo Profile Tool 

 Icon on the Power*Core Toolbar OR go under the File Menu in Power*Core and select the Core Photo 
Profile Tool. 

 

 

1. This will activate the Core Photo Cropping tool window shown below. 

 

Overview of Core Photo Cropping tool window. 

File Menu allows you to open a Core Graphic in this application. 

Profile Menu allows the user to Load a cropping profile that you have 
already done or save one that you are presently doing. 
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View Menu allows the user to turn on / off the Toolbar and or Status bar. 

 

 

Layout Menu allows the user to make all the cropping areas the same size as 
the highlighted rectangle when the make same size selection is activated. 

Note: It is important to be aware of your picture size. Laboratory photos will be taken at a very high resolution 
(~25mb) and can slow down the performance of your computer. You may wish to resize these pictures to increase the 
screen refresh issues that may occur. 

How to Create a Core Graphic profile. 
1. Once the Core Photo Cropping tool window has been open (shown above). The user can now click on the Open 

Graphic  button on the toolbar or click on Open Graphic from the File menu selection to activate the Open 
Picture File window. 

 
2. Locate your Core Photo and either double click on the file name or Click once on the file name and click on 

the  button. This will open the core photo in the Cropping window. 

Note: The user can zoom in or out with their roller button on the mouse or right click on the image and select 

scale to change the size of the photo. The user can also scroll the picture by using the scroll bars 
on the right and bottom of the application is the picture is bigger that the viewing area. 

 
3. Now click and drag an area around the first core sleeve. You will notice an outline where you have dragged 

following your mouse pointer. Let go your left mouse button and you will see a red outline around the area with a 
1 in the middle of it. This is shown on the below. 
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Note: If you already have a profile and wish to modify the crops you can now open the cropping file by clicking on the 

Profile Menu and select Load Profile or the user can click on the  Icon on the toolbar. You will be looking for a 
file with the *.cgp file extention. 

 
4. Now you can click and drag more outlines for the cropping you wish to do. After each drag you will see a 

sequential number inside the red designated cropped areas. The illustration on the next page has four (4) 
cropped areas at the top of an eight (8) sleeve photo. 

 
5. To Resize or Move you must first click on the defined area to activate it (area 4 shown above) and then you 

can move  by moving inside the defined cropping area, or resize  by mousing over the corners or sides over 
the black boxes and then click and drag to perform the resize or move. 

6. Once you have the right size (height and width) on one of your profiles (remains highlighted) you can then make 
all the other areas the same size by clicking on the profile menu selection and selecting height or width. This 
will activate the appropriate window and then Click on the  button. 
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7. The user can also align all the cropping areas left or right with the CTRL and Left or Right arrow keys on 

your keypad. 

8. The user can also fine tune the placements of the cropping areas by clicking on a cropping area and utilize the 
Up / Down / Left / Right arrow keys on your keypad. 

9. Now, once you finalize the cropping regions the user must save the profile by clicking on the 

Profile Menu selection and select Save Profile menu item OR click on the  icon on the 
toolbar. This will activate Save as window. 

 
10. Type in a file name and save in a location where you can access it later on the automated or manual import 

utility. 

11. Click on the  button. 

You can save as many profiles as you wish. Upper four (4) sleeves, Lower four (4) sleeves or all eight (8) sleeves etc. 
You now have some profiles which you can crop your core photos and stack them in the Core Photo stacked layer. 


